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1 硬件架构 

1.1 系统架构 

Gowin_EMPU(GW1NS-4C)，是由 MCU 内核系统和 FPGA 内核系统组

成的片上系统，如图 1-1 所示。 

图 1-1 系统架构 

 

 

MCU 内核系统，包括 MCU Core、AHB 总线及外部设备、AHB2APB 

Bridge、APB1 总线及外部设备等。 

FPGA 内核系统，包括 MCU 内核系统的时钟和复位信号输入、MCU 内

核系统的数据存储器（SRAM）和指令存储器（FLASH）、APB2 Bridge、

APB2 总线及外部设备等。 
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1.2 系统特征 

Gowin_EMPU(GW1NS-4C)，包括两个子系统： 

 MCU 内核系统 

 FPGA 内核系统 

1.2.1 MCU 内核系统 

MCU 内核系统包括： 

 MCU Core： 

- ARM Cortex-M3 Core，ARM architecture v7-M Thumb2 指令集架

构，支持 16-bit 和 32-bit 指令集 

- DAP（Debug Access Port） 

- Bus Matrix 

- NVIC（Nested Vector Interrupt Controller） 

- TPIU（Trace Port Interface Unit） 

 AHB 总线系统及外部设备 

- GPIO 

- AHB2 Master 用户扩展接口 

- AHB2 Slave 用户扩展接口 

 AHB2APB Bridge 

 APB 总线系统及外部设备 

- UART0 

- UART1 

- Timer0 

- Timer1 

- Watch Dog 

- RTC 

- APB2 扩展接口 

1.2.2 FPGA 内核系统 

FPGA 内核系统包括： 

 外部晶振时钟输入或内部晶振时钟，作为MCU 内核系统的系统时钟源，

系统时钟最高为 80MHz 

 复位信号输入，作为 MCU 内核系统的系统复位信号 

 6 个用户中断处理信号，用户扩展外部设备中断处理功能 

 AHB 扩展接口 

- SRAM 和 FLASH，作为 MCU 内核系统的数据存储器和指令存储器 

- 1 个 AHB2 Master 用户扩展接口 

- 1 个 AHB2 Slave 用户扩展接口 
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 APB2 扩展接口 

- SPI Master 

- I2C Master 

- 12 个 APB2 Master 用户扩展接口 

 Memory 

- MCU 内核系统数据存储器 SRAM Size，可以配置为 2KB、4KB、

8KB 或 16KB 

- MCU 内核系统指令存储器 FLASH Size，为 32KB 

1.3 系统端口 
Gowin_EMPU(GW1NS-4C)系统端口定义，如表 1-1 所示。 

表 1-1 系统端口定义 

名称 I/O 位宽 描述 所属模块 

sys_clk in 1 系统时钟信号 - 

reset_n in 1 系统复位信号 - 

trace_clk out 1 TPIU 时钟信号 
TPIU 

trace_data out [3:0] TPIU 数据输出信号 

user_int_0 in 1 用户中断处理信号 0 

NVIC 

user_int_1 in 1 用户中断处理信号 1 

user_int_2 in 1 用户中断处理信号 2 

user_int_3 in 1 用户中断处理信号 3 

user_int_4 in 1 用户中断处理信号 4 

user_int_5 in 1 用户中断处理信号 5 

gpio inout [15:0] 通用输入输出信号 GPIO 

uart0_rxd in 1 UART0 接收信号 
UART0 

uart0_txd out 1 UART0 发送信号 

uart1_rxd in 1 UART1 接收信号 
UART1 

uart1_txd out 1 UART1 发送信号 

scl inout 1 I2C 串行时钟信号 
I2C Master 

sda inout 1 I2C 串行数据信号 

mosi out 1 SPI 主设备输出/从设备输入信号 

SPI Master 
miso in 1 SPI 主设备输入/从设备输出信号 

sclk out 1 SPI 时钟信号 

nss out 1 SPI 从设备选择信号 

master_hclk out 1 Master 时钟信号 

AHB2 Master 

master_hrst out 1 Master 复位信号 

master_hsel out 1 Master 选择信号 

master_haddr out [31:0] Master 地址信号 

master_htrans out [1:0] Master 传输类型信号 

master_hwrite out 1 Master 读写方向信号 
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名称 I/O 位宽 描述 所属模块 

master_hsize out [2:0] Master 传输数据 Size 信号 

master_hburst out [2:0] Master burst 类型信号 

master_hprot out [3:0] Master 保护控制信号 

master_memattr out [1:0] Master memattr 信号 

master_exreq out 1 Matter exreq 信号 

master_hmaster out [3:0] Master 主机标号信号 

master_hwdata out [31:0] Master 写数据信号 

master_hmastlock out 1 Master 锁定标记信号 

master_hreadymux out 1 Master hreadymux 信号 

master_hauser out 1 Master hauser 信号 

master_hwuser out [3:0] Master hwuser 信号 

master_hrdata in [31:0] Master 读数据信号 

master_hreadyout in 1 Master hreadyout 信号 

master_hresp in 1 Master 传输状态信号 

master_exresp in 1 Master exresp 信号 

master_hruser in [2:0] Master hruser 信号 

slave_hsel in 1 Slave 选择信号 

AHB2 Slave 

slave_haddr in [31:0] Slave 地址信号 

slave_htrans in [1:0] Slave 传输类型信号 

slave_hwrite in 1 Slave 读写方向信号 

slave_hsize in [2:0] Slave 传输数据 Size 信号 

slave_hburst in [2:0] Slave burst 类型信号 

slave_hprot in [3:0] Slave 保护控制信号 

slave_hmaster in [3:0] Slave 主机标号信号 

slave_hwdata in [31:0] Slave 写数据信号 

slave_hmastlock in 1 Slave 锁定标记信号 

slave_hrdata out [31:0] Slave 读数据信号 

slave_hready out 1 Slave 准备好信号 

slave_hresp out 1 Slave 传输状态信号 

slave_hexresp out 1 Slave hexresp 信号 

slave_hruser out [2:0] Slave hruser 信号 

slave_hmemattr in [1:0] Slave hmemattr 信号 

slave_hexreq in 1 Slave hexreq 信号 

slave_hauser in 1 Slave hauser 信号 

slave_hwuser in [3:0] Slave hwuser 信号 

master_pclk out 1 APB2 Master 时钟信号 
APB2 Master 

[1-12] 
master_prst out 1 APB2 Master 复位信号 

master_penable out 1 APB2 Master 使能信号 
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名称 I/O 位宽 描述 所属模块 

master_paddr out [7:0] APB2 Master 地址信号 

master_pwrite out 1 APB2 Master 读写方向信号 

master_pwdata out [31:0] APB2 Master 写数据信号 

master_pstrb out [3:0] APB2 Master 写选通信号 

master_pprot out [2:0] APB2 Master 保护类型信号 

master_psel1 out 1 APB2 Master [1]选择信号 

APB2 Master [1] 
master_pready1 in 1 APB2 Master [1]准备好信号 

master_prdata1 in [31:0] APB2 Master [1]读数据信号 

master_pslverr1 in 1 APB2 Master [1]传输失败信号 

master_psel2 out 1 APB2 Master [2]选择信号 

APB2 Master [2] 
master_pready2 in 1 APB2 Master [2]准备好信号 

master_prdata2 in [31:0] APB2 Master [2]读数据信号 

master_pslverr2 in 1 APB2 Master [2]传输失败信号 

master_psel3 out 1 APB2 Master [3]选择信号 

APB2 Master [3] 
master_pready3 in 1 APB2 Master [3]准备好信号 

master_prdata3 in [31:0] APB2 Master [3]读数据信号 

master_pslverr3 in 1 APB2 Master[3]传输失败信号 

master_psel4 out 1 APB2 Master [4]选择信号 

APB2 Master [4] 
master_pready4 in 1 APB2 Master [4]准备好信号 

master_prdata4 in [31:0] APB2 Master [4]读数据信号 

master_pslverr4 in 1 APB2 Master[4]传输失败信号 

master_psel5 out 1 APB2 Master [5]选择信号 

APB2 Master [5] 
master_pready5 in 1 APB2 Master [5]准备好信号 

master_prdata5 in [31:0] APB2 Master [5]读数据信号 

master_pslverr5 in 1 APB2 Master[5]传输失败信号 

master_psel6 out 1 APB2 Master [6]选择信号 

APB2 Master [6] 
master_pready6 in 1 APB2 Master [6]准备好信号 

master_prdata6 in [31:0] APB2 Master [6]读数据信号 

master_pslverr6 in 1 APB2 Master[6]传输失败信号 

master_psel7 out 1 APB2 Master [7]选择信号 

APB2 Master [7] 
master_pready7 in 1 APB2 Master [7]准备好信号 

master_prdata7 in [31:0] APB2 Master [7]读数据信号 

master_pslverr7 in 1 APB2 Master[7]传输失败信号 

master_psel8 out 1 APB2 Master [8]选择信号 

APB2 Master [8] 
master_pready8 in 1 APB2 Master [8]准备好信号 

master_prdata8 in [31:0] APB2 Master [8]读数据信号 

master_pslverr8 in 1 APB2 Master[8]传输失败信号 

master_psel9 out 1 APB2 Master [9]选择信号 APB2 Master [9] 
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名称 I/O 位宽 描述 所属模块 

master_pready9 in 1 APB2 Master [9]准备好信号 

master_prdata9 in [31:0] APB2 Master [9]读数据信号 

master_pslverr9 in 1 APB2 Master[9]传输失败信号 

master_psel10 out 1 APB2 Master [10]选择信号 

APB2 Master [10] 
master_pready10 in 1 APB2 Master [10]准备好信号 

master_prdata10 in [31:0] APB2 Master [10]读数据信号 

master_pslverr10 in 1 APB2 Master[10]传输失败信号 

master_psel11 out 1 APB2 Master [11]选择信号 

APB2 Master [11] 
master_pready11 in 1 APB2 Master [11]准备好信号 

master_prdata11 in [31:0] APB2 Master [11]读数据信号 

master_pslverr11 in 1 APB2 Master[11]传输失败信号 

master_psel12 out 1 APB2 Master [12]选择信号 

APB2 Master [12] 
master_pready12 in 1 APB2 Master [12]准备好信号 

master_prdata12 in [31:0] APB2 Master [12]读数据信号 

master_pslverr12 in 1 APB2 Master[12]传输失败信号 

1.4 系统资源统计 
Gowin_EMPU(GW1NS-4C)系统资源统计，如表 1-2 所示。 

表 1-2 系统资源统计 

Resources 

Configuration 
LUTs Registers BSRAMs 

DSP 

Macros 

MCU Core Minimum 145 116 1 0 

MCU Core Default + Peripherals 468 285 8 0 
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2 硬件设计流程 

1.5 硬件环境 
 DK-START-GW1NS4 V1.1 

GW1NS-LV4CQN48C6H 

 DK-START-GW1NSR4 V1.1 

GW1NSR-LV4CQN48GC6H 

 DK-START-GW1NSER4 V1.1 

GW1NSER-LV4CQN48GC6H 

1.6 软件环境 
Gowin_V1.9.5.01 Beta 及以上版本。 

1.7 IP Core Generator 

Gowin 云源软件的 IP Core Generator，用于配置和产生

Gowin_EMPU(GW1NS-4C)硬件设计。 

IP Core Generator 软件使用方法，请参考 SUG284，Gowin IP Core 

Generator 用户指南。 

1.8 Programmer 

Gowin 下载软件 Programmer，支持 Gowin_EMPU(GW1NS-4C)硬件设

计码流下载。 

Programmer 软件使用方法，请参考 SUG502，Gowin Programmer 用

户指南。 

1.9 设计流程 

Gowin_EMPU(GW1NS-4C)硬件设计流程： 

 IP Core Generator 配置和产生 Gowin_EMPU(GW1NS-4C)硬件设计，

导入当前工程； 

 实例化 Gowin_EMPU(GW1NS-4C)，导入用户应用设计，连接用户应用

设计与 Gowin_EMPU Top Module； 

http://cdn.gowinsemi.com.cn/SUG284.pdf
http://cdn.gowinsemi.com.cn/SUG502.pdf
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 物理约束和时序约束； 

 Synplify Pro 或 GowinSynthesis 综合； 

 Place & Route 布局布线，产生码流文件； 

 Programmer 下载码流到 GW1NS-4C/GW1NSR-4C/GW1NSER-4C。 
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3 工程模板 

1.10 工程创建 

1.10.1 创建工程 

双击打开 Gowin 云源软件，选择菜单栏“File > New… > FPGA Design 

Project”，如图 3-1 所示。 

图 3-1 创建 FPGA Design 工程 
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1.10.2 设定工程名称和路径 

输入工程名称，选择工程路径，如图 3-2 所示。 

图 3-2 设定工程名称和路径 

 

1.10.3 选择器件 

选择 Series、Device、Package、Speed 和 Part Number，如图 3-3 所

示。 

以软件开发工具包 DK_START_GW1NS4_V1.1 参考设计为例，如下所

示。 

 Series：GW1NS 

 Device：GW1NS-4C 

 Package：QFN48 

 Speed：C6H 

 Part Number：GW1NS-LV4CQN48C6H 
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图 3-3 选择器件 

 

1.10.4 完成工程创建 

完成工程创建，如图 3-4 所示。 

图 3-4 完成工程创建 
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1.11 硬件设计 

使用 IP Core Generator 产生 Gowin_EMPU(GW1NS-4C)硬件设计。 

选择菜单栏“Tools > IP Core Generator”或工具栏 “IP Core Generator”

（ ），打开 IP Core Generator。 

选择“Soft IP Core > Microprocessor System > Hard-Core-MCU > 

Gowin_EMPU(GW1NS-4C) 1.0”，如图 3-5 所示。 

图 3-5 选择 Gowin_EMPU(GW1NS-4C) 

 
 

打开 Gowin_EMPU(GW1NS-4C)配置选项，系统结构如图 3-6 所示。 

其中置灰模块是系统默认，用户不可以配置；未置灰模块，请双击打开

该模块进行配置。 

用户可以选择配置的模块，包括： 

 TPIU 

 NVIC：6 个用户中断处理信号 USER_INT0~5 

 AHB2 Slave：FPGA 内核系统可以扩展 AHB2 Slave 用户设备 

 AHB2 Master：FPGA 内核系统可以扩展 AHB2 Master 用户设备 

 GPIO 

 UART0 和 UART1 

 RTC 

 SRAM：可以配置为 2KB、4KB、8KB 或 16KB，默认为 16KB 

 I2C：FPGA 内核系统集成 I2C Master 

 SPI：FPGA 内核系统集成 SPI Master 

 APB2 Master[1-12] ：FPGA 内核系统可以扩展 12 个 APB2 Master 用

户设备 
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图 3-6 系统结构图 

 

 

Gowin_EMPU(GW1NS-4C)，系统配置选项，如表 3-1 所示。 

表 3-1 系统配置选项 

配置选项 描述 

Enable TPIU 使能 TPIU，默认关闭。 

Enable USER_INT_0 使能用户中断处理信号[0]，默认关闭。 

Enable USER_INT_1 使能用户中断处理信号[1]，默认关闭。 

Enable USER_INT_2 使能用户中断处理信号[2]，默认关闭。 

Enable USER_INT_3 使能用户中断处理信号[3]，默认关闭。 

Enable USER_INT_4 使能用户中断处理信号[4]，默认关闭。 

Enable USER_INT_5 使能用户中断处理信号[5]，默认关闭。 

Enable GPIO 使能 GPIO，默认关闭。 

Enable UART0 使能 UART0，默认关闭。 

Enable UART1 使能 UART1，默认关闭。 

Enable RTC 使能 RTC，默认关闭。 
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配置选项 描述 

Enable AHB2 Master 使能 AHB2 Master 用户扩展接口，默认关闭。 

Enable AHB2 Slave 使能 AHB2 Slave 用户扩展接口，默认关闭。 

Enable I2C 使能 I2C Master，默认关闭。 

Enable SPI 使能 SPI Master，默认关闭。 

Enable APB2 Master 1 使能 APB2 Master [1]用户扩展接口，默认关闭。 

Enable APB2 Master 2 使能 APB2 Master [2]用户扩展接口，默认关闭。 

Enable APB2 Master 3 使能 APB2 Master [3]用户扩展接口，默认关闭。 

Enable APB2 Master 4 使能 APB2 Master [4]用户扩展接口，默认关闭。 

Enable APB2 Master 5 使能 APB2 Master [5]用户扩展接口，默认关闭。 

Enable APB2 Master 6 使能 APB2 Master [6]用户扩展接口，默认关闭。 

Enable APB2 Master 7 使能 APB2 Master [7]用户扩展接口，默认关闭。 

Enable APB2 Master 8 使能 APB2 Master [8]用户扩展接口，默认关闭。 

Enable APB2 Master 9 使能 APB2 Master [9]用户扩展接口，默认关闭。 

Enable APB2 Master 10 使能 APB2 Master [10]用户扩展接口，默认关闭。 

Enable APB2 Master 11 使能 APB2 Master [11]用户扩展接口，默认关闭。 

Enable APB2 Master 12 使能 APB2 Master [12]用户扩展接口，默认关闭。 

SRAM Size 配置数据存储器 Size，可以配置为 2/4/8/16KB，默认 16KB。 

1.11.1 TPIU 配置 

双击打开 TPIU，可以选择配置 TPIU，如图 3-7 所示。 

如果选择 Enable TPIU，则 Gowin_EMPU(GW1NS-4C)支持 TPIU，默

认关闭。 
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图 3-7 TPIU 配置 

 

1.11.2 NVIC 配置 

双击打开 NVIC，可以选择配置用户中断处理信号 USER_INT_0~5，作

为 FPGA 内核系统用户扩展外部设备中断处理功能的中断处理信号，如图

3-8 所示。 

 如果选择 Enable USER_INT_0，则 Gowin_EMPU(GW1NS-4C)支持用

户中断处理信号[0]，默认关闭。 

 如果选择 Enable USER_INT_1，则 Gowin_EMPU(GW1NS-4C)支持用

户中断处理信号[1]，默认关闭。 

 如果选择 Enable USER_INT_2，则 Gowin_EMPU(GW1NS-4C)支持用

户中断处理信号[2]，默认关闭。 

 如果选择 Enable USER_INT_3，则 Gowin_EMPU(GW1NS-4C)支持用

户中断处理信号[3]，默认关闭。 

 如果选择 Enable USER_INT_4，则 Gowin_EMPU(GW1NS-4C)支持用

户中断处理信号[4]，默认关闭。 

 如果选择 Enable USER_INT_5，则 Gowin_EMPU(GW1NS-4C)支持用

户中断处理信号[5]，默认关闭。 
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图 3-8 NVIC 配置 

 

1.11.3 GPIO 配置 

双击打开 GPIO，可以选择配置 GPIO，如图 3-9 所示。 

如果选择 Enable GPIO，则 Gowin_EMPU(GW1NS-4C)支持 GPIO，默

认关闭。 
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图 3-9 GPIO 配置 

 

1.11.4 UART 配置 

双击打开 UART0 或 UART1，可以选择配置 UART0 和 UART1，如图

3-10 所示。 

 如果选择Enable UART0，则Gowin_EMPU(GW1NS-4C)支持UART0，

默认关闭。 

 如果选择Enable UART1，则Gowin_EMPU(GW1NS-4C)支持UART1，

默认关闭。 
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图 3-10 UART 配置 

 

1.11.5 AHB2 Master/Slave 配置 

双击打开 AHB2 Master 或 AHB2 Slave，可以选择配置 AHB2 Master

和 AHB2 Slave，如图 3-11 所示。 

 如果选择 Enable AHB2 Master，则 Gowin_EMPU(GW1NS-4C)支持

AHB2 Master，默认关闭。 

 如果选择 Enable AHB2 Slave，则 Gowin_EMPU(GW1NS-4C)支持

AHB2 Slave，默认关闭。 

 AHB2 Master 用户扩展外部设备的基地址映射：0xA0000000。 
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图 3-11 AHB2 Master/Slave 配置 

 

1.11.6 SRAM 配置 

双击打开 SRAM，可以选择配置 SRAM Size，如图 3-12 所示。 

默认 SRAM Size 为 16KB，可以选择配置 SRAM Size 为 2KB、4KB、

8KB 或 16KB。 
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图 3-12 SRAM 配置 

 

1.11.7 I2C 配置 

双击打开 I2C，可以选择配置 I2C Master，如图 3-13 所示。 

如果选择Enable I2C，则Gowin_EMPU(GW1NS-4C)支持 I2C Master，

默认关闭。 



3 工程模板 1.11 硬件设计 

 

IPUG932-1.0 21(30) 
 

图 3-13 I2C 配置 

 

1.11.8 SPI 配置 

双击打开 SPI，可以选择配置 SPI Master，如图 3-14 所示。 

如果选择 Enable SPI，则 Gowin_EMPU(GW1NS-4C)支持 SPI Master，

默认关闭。 
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图 3-14 SPI 配置 

 

1.11.9 APB2 Master 配置 

双击打开 APB2 Master[1-12]，可以选择配置 APB2 Master [1-12]，如

图 3-15 所示。 

 如果选择 Enable APB2 Master 1，则 Gowin_EMPU(GW1NS-4C)支持

APB2 Master [1]，默认关闭。 

 如果选择 Enable APB2 Master 2，则 Gowin_EMPU(GW1NS-4C)支持

APB2 Master [2]，默认关闭。 

 如果选择 Enable APB2 Master 3，则 Gowin_EMPU(GW1NS-4C)支持

APB2 Master [3]，默认关闭。 

 如果选择 Enable APB2 Master 4，则 Gowin_EMPU(GW1NS-4C)支持

APB2 Master [4]，默认关闭。 

 如果选择 Enable APB2 Master 5，则 Gowin_EMPU(GW1NS-4C)支持

APB2 Master [5]，默认关闭。 

 如果选择 Enable APB2 Master 6，则 Gowin_EMPU(GW1NS-4C)支持

APB2 Master [6]，默认关闭。 

 如果选择 Enable APB2 Master 7，则 Gowin_EMPU(GW1NS-4C)支持

APB2 Master [7]，默认关闭。 

 如果选择 Enable APB2 Master 8，则 Gowin_EMPU(GW1NS-4C)支持

APB2 Master [8]，默认关闭。 

 如果选择 Enable APB2 Master 9，则 Gowin_EMPU(GW1NS-4C)支持

APB2 Master [9]，默认关闭。 
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 如果选择 Enable APB2 Master 10，则 Gowin_EMPU(GW1NS-4C)支持

APB2 Master [10]，默认关闭。 

 如果选择 Enable APB2 Master 11，则 Gowin_EMPU(GW1NS-4C)支持

APB2 Master [11]，默认关闭。 

 如果选择 Enable APB2 Master 12，则 Gowin_EMPU(GW1NS-4C)支持

APB2 Master [12]，默认关闭。 

图 3-15 APB2 Master[1-12]配置 

 

 

APB2 Master [1-12]用户扩展外部设备的基地址映射，如表 3-2 所示。 

表 3-2 APB2 Master [1-12]基地址映射 

APB2 Master Address Size(Byte) 

1 0x40002400 256 

2 0x40002500 256 

3 0x40002600 256 

4 0x40002700 256 

5 0x40002800 256 

6 0x40002900 256 

7 0x40002A00 256 

8 0x40002B00 256 

9 0x40002C00 256 

10 0x40002E00 256 
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APB2 Master Address Size(Byte) 

11 0x40002E00 256 

12 0x40002F00 256 

1.11.10 综合工具配置 

完成 Gowin_EMPU(GW1NS-4C)功能配置后，选择产生

Gowin_EMPU(GW1NS-4C)硬件设计的综合工具 Synplify Pro 或

GowinSynthesis，如图 3-16 所示。 

图 3-16 综合工具配置 

 

1.12 用户设计 
 完成 Gowin_EMPU(GW1NS-4C)配置后，产生

Gowin_EMPU(GW1NS-4C)硬件设计 

 实例化 Gowin_EMPU(GW1NS-4C) Top Module 

 导入用户应用设计，连接 Gowin_EMPU(GW1NS-4C) Top Module 与用

户应用设计，形成完整的 RTL 设计 
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1.13 约束 

完成用户 RTL 设计后，根据使用的开发板和需要输入输出的 IO，产生

物理约束文件。 

根据时序要求，产生时序约束文件。 

物理约束和时序约束的产生方法，请参考 SUG101，Gowin 设计约束指

南。 

1.14 综合选项配置 
综合选项配置，如图 3-17 所示。 

 选择综合工具 Synplify Pro 或 GowinSynthesis； 

 根据设计中的实际顶层模块名称，配置 Top Module/Entity； 

 根据设计中的实际文件路径，配置 Include Path。 

图 3-17 综合选项配置 

 

1.15 综合 

运行 Gowin 云源软件的综合工具 Synplify Pro 或 GowinSynthesis，完

成 RTL 设计的综合，如图 3-18 所示。 

http://cdn.gowinsemi.com.cn/SUG101.pdf
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图 3-18 综合 

 

 

综合工具的使用方法，请参考 SUG100，Gowin 云源软件用户指南。 

1.16 布局布线 

运行 Gowin 云源软件的布局布线工具 Place & Route，完成布局布线，

产生码流文件，如图 3-19 所示。 

http://cdn.gowinsemi.com.cn/SUG100.pdf
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图 3-19 布局布线 

 

 

布局布线工具使用方法，请参考 SUG100, Gowin 云源软件用户指南。 

1.17 下载 

使用Gowin云源软件的Programmer下载软件，下载硬件设计码流文件。 

在 Gowin 云源软件中或安装路径下，打开下载软件 Programmer。 

单击 Programmer 菜单栏“Edit > Configure Device”或工具栏 

“Configure Device”（ ），打开 Device configuration。 

如果是器件 GW1NS-4C/GW1NSR-4C，下载选项配置，如图 3-20 所示。 

 Access Mode 下拉列表，选择“MCU Mode”选项。 

 Operation 下拉列表，选择“Firmware Erase, Program”选项或“Firmware 

Erase, Program, Verify”选项。 

http://cdn.gowinsemi.com.cn/SUG100.pdf
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图 3-20 器件 GW1NS-4C/GW1NSR-4C 下载选项配置 

 

 

如果是器件 GW1NSER-4C，下载选项配置，如图 3-21 所示。 

 Access Mode 下拉列表，选择“SecureFPGA Mode”选项。 

 Operation 下拉列表，选择“Firmware Erase, Program Securely”选项。 

图 3-21 器件 GW1NSER-4C 下载选项配置 

 

 

 “Programming Options > File name”选项，导入

Gowin_EMPU(GW1NS-4C)硬件设计码流文件。 

 单击“Save”，完成下载选项配置。 
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注！ 

“FW/MCU Input Options > Firmware/Binary File”选项，导入 Gowin_EMPU(GW1NS-4C)

软件编程设计二进制 BIN 文件，请参考 IPUG928, Gowin_EMPU(GW1NS-4C) IDE 软件参

考手册。 

完成 Device configuration 后，单击 Programmer 工具栏 

“Program/Configure”（ ），完成 Gowin_EMPU(GW1NS-4C)的下载。 

下载软件 Programmer 使用方法，请参考 SUG502, Gowin Programmer

用户指南。

http://cdn.gowinsemi.com.cn/SUG502.pdf
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4 参考设计 

Gowin_EMPU(GW1NS-4C)提供硬件参考设计，通过链接获取如下参考

设计，点击此链接获取如下参考设计：

cdn.gowinsemi.com.cn/Gowin_EMPU_V1.0.zip： 

Gowin_EMPU\ref_design\FPGA_RefDesign 

http://cdn.gowinsemi.com.cn/Gowin_EMPU_V1.0.zip
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